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Welcome to the latest edition of my monthly Final Cut Studio newsletter for December, 2009 - 
Part 1.

The goal of this newsletter is to provide information helpful to the interested user 
of Final Cut Pro. This newsletter publishes each month, past issues are available 
in my store. All software references are to Final Cut Studio 2 unless otherwise 
noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll 
find daily tips, the latest industry news, and over 450 articles and tutorials to help 
you get the most out of Final Cut!
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WELCOME

First, and most important -- a VERY Happy Holidays to you! 

This is the first of two newsletters this month. You can read part 2 here. 

http://www.larryjordan.biz/nxltrs/nxltr_63.html


I had the best of intentions to get this newsletter done sooner, but... I seemed to have run into a 
severe shortage of time recently.

Judging from my emails, work is still very scarce on the ground for many of us at the moment -- 
which really makes the holidays difficult to enjoy. I'm keeping my fingers crossed that work starts 
improving for all of us after the first of the year.

Since I'm so behind in getting these newsletters out, I'm going to focus on reader mail in this 
issue. I have a backlog of over 100 messages that are worth sharing. 

Here are the office, during the last several months, we have been working on a lot of new stuff - 
the first of which we can talk about now, the rest I hope to be able to show you next month. We 
are releasing a new series of video tutorials through MacProVideo for people new to video and 
our industry. I'll have more on that in a minute.

Earlier in December, I took the Digital Production BuZZ podcast to Government Video Expo 2009 
in Washington, DC. You can see the complete list of our shows here. However, I want to call 
special attention to four conversations:

Show 3: Eric Zaino, Matrox, about their family of MXO products 
Show 4: The Buzz - Steve Savanyu, Audio-Technica, and Peter Fannon, 
Panasonic. 
Show 5: Jerry Krulewicz, Wireworks.

All our interviews were interesting. These four were standouts.

As our thoughts turn to family and friends this holiday season, I want to take a moment to thank 
you for your time, interest, and emails supporting this newsletter. I love hearing from all of you - 
even when we disagree.

2009 is behind us. 2010 is just ahead. May the new year bring your wishes to life - and enough 
work to keep us all busy.
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THOUGHTS ON PRODUCT REVIEWS

After my last newsletter (way back in October), Eric Mittan, from WSIL-TV, sent me a very 
thought-provoking message. 

On a recent episode of This Week in Media with Daisy Whitney, a topic of 
discussion was the FTC's recent regulations to require any bloggers that review 
products from companies that have ever been advertisers or promotional partners 
with the blogger to include a disclaimer in the review explaining the relationship.

I only bring it up because I know Drobo has sponsored the Buzz in the past, and I 
didn't see anywhere in the review or your newsletter where you stated this.

Larry replies: This set off a long-string of reflections on my part which I want to share with you, 
because there is the potential for conflict-of-interest here that I want to avoid. 

http://www.gvexpo.com/
http://www.gvexpobuzz.com/
http://www.digitalproductionbuzz.com/Archives/LiveThatExpo.php?day1date=2009-11-30
http://www.digitalproductionbuzz.com/Archives/LiveThatExpo.php?day1date=2009-11-30
http://www.digitalproductionbuzz.com/Archives/LiveThatExpo.php?day1date=2009-11-30
http://www.emittan.com/


Over the last year, as my company has gotten bigger we have taken on more projects. These fall 
into three main areas:

* Seminars 
* Podcasts 
* This newsletter and website.

Of the three, the only one in which I formally review products is this newsletter, and by extension 
my LarryJordan.biz website, where those reviews are permanently posted. However, I am 
actively soliciting sponsors or advertisers for my seminars and podcasts to allow me to keep 
costs low and extend our trainingand events into new markets. 

My criteria for selecting what products to review are that:

1.  It needs to be relevant to video production or post-production.
2.  I need to be able to understand it well enough to explain it.
3.  I need to feel it is worth the time and effort to review.
4.  I need to be able to contribute something meaningful to the discussion about this product. 

When I began writing this newsletter six years ago, I set several rules that govern my reviews:

1.  I do not accept payment to review a product. 
2.  To the best of my ability, I write my reviews to be objective, based on real-world 

scenarios, and not colored by who is, or is not, an advertiser.
3.  I do not allow anyone else to ghost-write my product reviews. I welcome other opinions to 

this newsletter, however I make sure to put the writer's name on anything I did not write. 
4.  I will clearly acknowledge any and all sponsorships. There is never any "secret money."
5.  Anyone, readers or manufacturers, can suggest a product for me to review. However, I'm 

the only one that decides what reviews I will do.
6.  Whether a company decides to sponsor one of my seminars or advertise on my podcasts 

(or websites) has no effect on what I choose to review, the content of my reviews, or my 
opinions.

However, I can't afford to buy all the hardware that I'd like to test. So, when testing hardware, I 
ask manufacturers to loan me a unit for a couple of weeks to test. When my review is complete, I 
return the unit to them. It is very tempting to keep the free gear, but it is not ethical.

This same rule is mostly true for software. Some software I buy before reviewing. Other times, 
I'm given demo copies.

So, going forward, I'm adding a new rule:

7. Whenever I review a product, I will indicate where it came from and whether any 
conditions were attached to the review. If they have been a sponsor for anything 
I've done in the past, I will acknowledge that. 

I have worked very hard to make this newsletter a trustworthy resource containing useful 
information for Final Cut editors. I'm very proud of it and all your email in support of it. 

Finally, though, like many of us, I run a business with payroll and rent to meet. Advertisers and 
sponsors are an important part of that mix, especially for funding podcasts and seminars. Eric's 
comments made me realize I needed to clarify my policy and share it with you. I will, I'm sure, 
make mistakes. However, they will be honest mistakes and I'll correct them as fast as I can.

As always, feel free to write. I love hearing from you.

UPDATE - Dec. 27, 2009

http://www.larryjordan.biz/


Loren Miller writes: 

I very much like your rules for the road regarding reviews and disclosure. It was 
"WTO"- well thought out. I get plenty of NFR's to review and I've never thought I 
needed to disclose that; its an established industry practice to generate publicity 
for products by writers who often couldn't otherwise afford access to them.

You're in a special case, though, because you accept advertising. You've mapped 
out a very ethical path.

Larry replies: Thanks, Loren. Conflict of interest is something I worry about a lot -- and I realized I 
needed to spell this out, both for readers and myself. 

[ Go to Top. ] 

LARRY RELEASES NEW VIDEO TUTORIALS ON MACPROVIDEO.COM

One of the requests I get a lot is 
for a series of introductory 
videos for people that are new 
to the industry.

So, over the last several months, I've been working on a series of short video tutorials that 
answer basic video questions, without getting bogged down in specific technology. These are 
designed for interested beginners, rather than experienced professionals.

Currently, I have eleven episodes created with two more to arrive before the end of this year. 
Each tutorial runs 6-10 minutes and topics include:

* Improve your Shooting in HD 
* Tips to Improve Audio 
* Tips to Improve Lighting 
* Getting Organized for Editing 
* Picking the Right Microphone 
* Lighting with Soft-lights

Thanks to a new partnership with MacProVideo, all these tutorials can be downloaded, or viewed 
in their on-line library. If this first set of tutorials proves popular, I'll be off to the studio to shoot 
some more. 

MacProVideo started a whole new section for us -- called Audio/Video Fundamentals. My 
tutorials are in the Digital Production BuZZ section. 

If you are just starting out, or have a friend that is pestering you for guidance, take a look at 
these tutorials. These aren't available anywhere else and are designed to help new users avoid 
unnecessary mistakes. Let me know what you think.

Find out more here: http://www.macprovideo.com/tutorials/avfundamentals

Also, I've also released one of my most popular tutorials through MacProVideo as well:  
Picking the Right HD Video Format. You can find it on this page, as well. 

http://www.macprovideo.com/tutorials/avfundamentals
http://www.macprovideo.com/tutorials/avfundamentals
http://www.macprovideo.com/tutorials/avfundamentals
http://www.macprovideo.com/tutorials/avfundamentals
http://www.macprovideo.com/tutorials/avfundamentals
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COMMENTARY: A LOVE LETTER TO LIVETYPE

Recently, on an Apple Trainers listserv that I subscribe to, a discussion began on LiveType vs. 
Motion. its no secret that I am a fan of LiveType, so I added my two cents to the discussion. 

As it progressed, Charles Meyer, the Product Manager for Motion at Apple, joined in. He made 
two comments that spurred this commentary:

As the Motion Product Marketing Manager I want to make sure that I help our 
design and engineering team build the best possible product for the market. We 
will never have enough resources to build everything we want to build, or 
everything that you want to see in the product so we have to keep making tough 
decisions. I can however definitely say that making sure that we provide the best 
titling environment for Final Cut Pro users is at the top of my list.

I read some of your feedback that Motion did not do everything that LiveType did. I 
hear the general feedback that LiveType was easier to use (IMHO - in part 
because it had a whole lot less that it could do) and I welcome feedback you might 
have about specific of the Motion experience that you feel might not make it as 
easy to use for LiveType qualified type of work. 

What is it really about Motion that make it scary to LiveType Users?

I immediately sent Charles a note thanking him for his interest and willingness to participate in 
the discussion. It is always reassuring when Apple indicates it is actually listening. 

Then, I started thinking. I use LiveType almost daily. I use Motion only when forced. Why? 

So I thought I'd answer Charles' question in this newsletter. If you have points you want to add, 
or disagree with, I'll add those as well. Then, I'll send this all to Charles as one more set of 
opinions from Final Cut editors.

There's no question Motion is the application of the future. LiveType is supported by FCP 7, but 
not bundled with it. There's no doubt this support will disappear in future versions of FCP. So, it 
is in all our interests to make Motion as good as it can possibly be.

It is also true that Motion does FAR more than LiveType ever did. Motion is a full-featured motion 
graphics software. LiveType animates text. However, many times, animating text - either full-
screen or lower-thirds - is all I need. 

LiveType and Motion are very similar in how they approach text animation. However...

�●     LiveType is a one-trick pony -- it animates text. Motion is much more complex. It is 
designed to be a complete motion graphics program, of which animating text is only a 
small part. 
 

�●     LiveType has four windows, all visible. Motion has four windows, two of them hidden, and 
nine different tabs scattered across all four windows. 
 

�●     LiveType can have multiple projects open at once; all displayed using standard project 
tabs. Motion allows multiple open projects as well, but Motion hides all projects except the 
current one. And, if more than one project is running in Motion, there is a serious 
performance penalty.  



 
�●     LiveType has its file library easily accessible in the Media Browser window, consisting of 

five tabs. Motion stores its files in the Library tab, sorted into 19 category folders, each 
category contains multiple folders and thousands of files. 
 

�●     LiveType categorizes Backgrounds, Objects, and Effects by categories. Motion dumps all 
backgrounds into one folder, while mortises, mattes, and other objects are scattered 
throughout the Content folder in no discernable order.  
 

�●     When it comes to animating text Motion is overkill. I will never design the opening to 
Monday Night Football. Instead, I want to quickly start an application, find a background, 
add some text, animate it, and get back to editing in Final Cut.  
 

�●     LiveType does not support cropping or blend modes, Motion does. 

Here's what I'd like Motion to do that will approach the simplicity of LiveType:

1. Provide the same distinction between Foreground and Background as LiveType 
does; so that I can easily import a graphic, freeze frame, or video, place it on the 
background, animate some text on top, then have the choice to either export the 
background or not export the background.

2. I'd like all loopable, full-screen backgrounds to be stored in their own Library 
folder, called "Backgrounds," and sorted into categories similar to the way 
backgrounds are categorized in LiveType. In Motion currently, all backgrounds are 
in a single folder in the Content folder.

3. I'd like the ability to easily see which projects are open, similar to FCP and 
LiveType, where I can click between them to make sure I am consistent in the look 
and feel of my projects. I don't want a performance hit for having more than one 
project open at once.

4. When you search for Backgrounds in the Library search box, I'd like all 
backgrounds displayed. Currently, entering "Backgrounds" into this search box 
displays no animated backgrounds.

5. I'd like a keyboard shortcut that, when pressed, displays the Library > 
Backgrounds folder, opens the Timeline window, and selects the Text tool. in 
other words, a layout similar to LiveType. 

6. I'd like an easy way to loop a background to extend its duration.

7. I'd like an easy way to find the two controls I use most often for text effects in 
LiveType: Sequence and Speed.

8. I'd like an easy way to matte video into text, similar to the matte pop-up menu in 
LiveType.

I'm sure, as LiveType slowly fades away, I'll start using Motion more and more. But, for now, I 
find Motion intimidatingly complex. This complexity is important when you are creating opening 
animation for Monday Night Football. But it gets in the way of creating simple text animations on 
a moving background, quickly and easily.

I'm interested in your comments. Email me your suggestions and I'll add them below.

UPDATE - Dec. 27, 2009

Philip King writes: 



Just read your post. I can't even imagine how I would go about doing something 
so easy to do in Live Type in Motion instead. 

Rather than kill it, they need to bundle it back with Final Cut Express and leave it. I 
know that would mean people having to own both FCP and Express to have Live 
Type, but I'm one of those people who do. I use Express on a laptop and its great 
for doing simple one camera work remotely.

I just opened Motion to look at how I might start doing titles in Motion. Just a little 
intimidating.... 

Gray Jones adds:

I have built up many templates in Livetype over the years (in other words, older 
Livetype projects that I tweak and replace text in for use in newer jobs). It bugs me 
to no end that while the newest Motion/FCP can OPEN livetype projects, they see 
them as uneditable flattened video footage. This forces me to go back to Livetype 
to edit the text or make any changes.

If Motion could actually edit the Livetype projects (or at least translate them into 
editable Motion projects), it might encourage me to stay around in Motion longer 
and not go back to Livetype as much. 

Loren Miller writes: 

[When you wrote] "1. Provide the same distinction between Foreground and 
Background as LiveType does..." -- this might need just a touch more thought!

WHICH foreground; WHICH background? Motion as you indicate is far more than 
LiveType. It lives by layers, often many deep. To pigeonhole these into foreground/
background? Not sure that works.

I guess layer groups for FG or BG could be stored in these which helps organize 
large projects, rather like PreRenders and PreCompose in AfterEffects. But it 
seems a limited way to think about more elaborate Motion projects. Maybe user-
defined folders do the trick and basic FG/BG already established would do no 
harm as long as veteran users can generate any number of storage folders for 
project purposes-- like adding a "MIddleground" folder? Or tthree? And each 
supporting easy render-output.

Ben Balser sent me a long email, which I've edited to include here:

The unacknowledged first drawback in removing of LiveType (from my perspective 
as a trainer, both AATC and independent such as yourself) has caused Final Cut 
Studio 3 to have an increased learning curve, removing some of the "ease of 
learning to get things done" FCS was always known for.... 

The second unacknowledged drawback is that we miss the wonderful library of 
animated backgrounds, elements, and templates in LiveType....

As a Certified Apple trainer; Motion is VERY intimidating for my consulting clients, 
students, and user group member to try to learn.... It is not only "perceived" as 
tougher to learn and use than LiveType was, it actually is. 

Thus my wish list is very similar to yours:



1.  Incorporate LiveType's separation of foreground/background tracks, 
including the option to not include backgrounds in the final export/render 
(as you've pointed out).

2.  Give us project tabs in Motion to keep track of multiple projects (as you've 
pointed out).

3.  Clean up the confusing Library folders (as you've pointed out).
4.  Package all elements, animated backgrounds, and templates from 

LiveType into Motion so we don't "lose" functionality and convenience. 
5.  Create a "Text In Final Cut Studio 3" APTS book and class, so folks can 

learn to do text quick and easy like in LiveType, and not have to learn the 
other 99% of Motion, when all they want to do is fancy animated text.

6.  Be more clear about Motion's graphic card requirements, its very confusing 
as to what "realistically" works, this was never an issue with LiveType, and 
even some "standard" graphics cards cause Motion to crash.

Mike Krause adds:

Like you, I'm a fan of LiveType. And, like you, I'm more than a bit disappointed 
with it being dropped from the Final Cut Studio bundle. 

I truly expected to see a revamped version of it available as a plug-in style text tool 
for FCP, like Boris. Maybe we'll get lucky and Apple will choose to do something 
similar in future updates of FC Studio, or even offer it up to developers so some 
third party will do just that. Probably not, but one can always dream.

Another group of things I really like(d) about using LiveType is that the round-
tripping with FCP is seamless, and its clips render much more quickly than similar 
Motion clips. 

I think it'd be a waste of a useful program for LiveType to fade away - the 
capabilities of Motion notwithstanding - and I really hope to see it resurrected as a 
low-cost plug-in for those of us who know when we need to use Motion and know 
when we need something simpler to save time.

Alan Hartman adds:

Although I have had LiveType for a while, I never fully investigated it until I started 
purchasing some Digital Juice fonts. I am not sure you are familiar with the 
company or the products, but they have a plug-in for their font products which 
enable you to export their massive font libraries to LiveType. It is seemless and 
gives LiveType a "kick-in-the-pants" as far as to the range of beautiful styles of 
fonts available.

UPDATE - Dec. 28, 2009

Terry Solenberger sent me his thoughts:

I agree that Motion's Library needs better organization and take could take a few 
lessons from how LiveType's content was presented in its application. But as far 
as the background issue, that is what always confused me with LiveType. Final 
Cut Pro has channels of video which act very much like layers. In Adobe 
Photoshop, Illustrator and After Effects, you work in layers. Why Apple separated 
the background layer from the foreground is beyond me.

Maybe it is because I come from a Graphic Design background rather than a 
traditional editorial background, layers make more since. In Motion you can 
designate a background layer, lock it and do any title work on top. Then turn it off 
when exporting, thus mimicking LiveType's export option. At least that is a work-
around.

http://www.digitaljuice.com/


Also performance must be improved in Motion. There needs to be better multi-
processor support, support for more than just 4GB of total system RAM, and 64-bit 
support in future versions. Otherwise all that hardware and system architecture is 
really going to waste on what potential Motion has.

Timothy Barksdale writes:

Totally agree with the value of Livetype.

A story might help to get this across to the folks at Apple. Long ago (10 years) 
there was a small but very elegant program called Microsoft Word. Some where 
around Word 4 or 5 ( for Mac) it began to grow. Suddenly, the small elegant 
program became a monster. It became more difficult to use because the software 
engineers at Microsoft decided to add many more features. Certainly, that would 
make every users life better- right? The size of the program bloated and the 
reviews were not great. I switched from a program I loved to a new one because in 
the cycle of development of MacOS basic functions and machines -it stopped 
working. WordPerfect became my Word processing program for several years 
until it too abandoned its Mac customer base.

This seems to be the cycle of Livetype and Motion as well. I won't even mention 
the frustration about an elegant program within Final Cut StudioPro- DVD and how 
Blu-ray is still basically ignored .

I see a huge market developing in Blu-ray for the nature customers I create 
programming for. But Apple continues to ignore many repeated requests to 
maintain and allow us to create a Blu-ray DVD simply, using a program we are 
familiar with. 

One of the 20th Centuries most important business leaders was a man named 
Peter Drucker. Of the five major principles he encouraged all of us to constantly 
stay in touch with, one of the most important was : What does the customer value?

When i come home from 1 month or 6 months filming around the world the last 
thing I need is more complication. That is why I will end up with a dedicated Mac 
G-5 Workstation running things in the simple early stages with programs like 
Livetype. When newer programs will not allow the incorporation of materials from 
this it will be time to examine what works and what has become bloated again.

Tamar writes:

I am a big fan of LiveType as well, and sorry to hear it will not be included in future 
versions of FCS.

One major advantage of LiveType that Motion lacks, which is crucial for me and I 
guess for many other users around the world, is compatibility with Right to Left 
(RTL) languages.

In LiveType there are two different controls regarding the way an animtion will 
play: from right/from left, and forward/backward. In RTL language, such as 
Hebrew, I can choose "from right" and an animation will start from the first letter in 
a Hebrew word and still play farward, choosing "backward" does a different thing, 
and plays the animation in reverse.

In motion there's only one control - direction, in which there two options: from left 
to right and from right to left, but it behaves as forward/backward in LiveType. 
There's no option to start the amination from the first letter on the right, and still 



play it forward.

So basically there's no possibility to animate text properly in RTL languages.

Editors who work in Hebrew, Arabic, Persian and other languages are affected 
from this major downgrade in the FCS bundle features.

I hope you'll be able to help and pass Apple the frustration that this situation 
causes.

Remy Deveze writes from Paris:

I prefer LiveType when I have to put (text + textures+ background) in a FCP 
project. Specially when I am in a hurry and dont have time to personnalise the 
presets.  
This is unfortunatly most of the time.

For any other animation, I choose Motion. And even for text, when I have time, I 
do prefer Motion because I think its more easy and confortable to customize 
presets, play with all parameters, set new keyframes…

Richard Osso adds:

I read your newsletter and the article on Live Type really hit home. Your 
suggestions were all the thoughts that I need and want in any adjustment that 
Motion may make.

I would love to see a TAB in Motion that takes you to a TEXT world. There in this 
TEXT WORLD within Motion, it should have all the items you mention.

Once upon a time, when I needed to clean up audio, I played with BASS & 
TREBLE. It was simple and I was done.

Then authors thought they were doing us a favor by giving us CONTROL over a 
million features and the evolution of SOUNDTRACK PRO and others came about. 
It got complicated. No, let me say that again. It got VERY complicated. Fixing 
problems now took too much time and playing with several controls, and the audio 
got worse in some instances.

As you mention, I am not making a feature intro for ESPN or the movie Titanic. I 
need a few steps to get to titles I can use.

I am an event videographer. I don't have a lot of time to PLAY, LEARN or 
CREATE something new each time. I have a few favorite fonts and backgrounds I 
use. SIMPLE - DONE - ELEGANT

So how important is it for me NOT to lose LIVE TYPE with a complicated Motion 
interface that is so full of controls and steps to make SIMPLE ELEGANT text for 
my video, that I have NOT upgraded to FCP7 or Leopard.

I do not want to lose LIVE TYPE for a more complicated replacement. Until I see 
something that works as easy as LIVE TYPE, I refuse to upgrade until I have to.

ASK APPLE to allow us to keep LIVE TYPE within FCP so I can use all my 
favorites.



Jeffrey Singer adds:

I think Livetype is highly underrated as a general animation tool. It is far easier to 
use than Motion, and almost as flexible. In Livetype, I use it for object animation, 
not just animated text.

In Livetype, letters are called “Glyphs.” In essence, they are “objects” that look like 
letters. These “Glyphs” can be animated (effects) as a group (a word) or 
individually. 
If you import another graphic object (using the “place” command), such as a logo 
or picture or even a movie file, you can animate them using the effects normally 
used on letters and words.

If you have aftermarket effects (such as Livetype Central’s packs) you have many, 
many, premade, customizable effects, that are easier to use and faster to render 
than anything in Motion.

Larry replies: Thanks, everyone, for all of your comments. 

And, Ben, thanks for reminding me that Motion requires special graphics cards, while LiveType 
does not. 

[ Go to Top. ] 

CHECK OUT MY LATEST VIDEO TUTORIALS AND BUNDLES!

I'm working on more tutorials for Final Cut Pro 7. In the meantime, take 
a look at over FIFTY tutorials and bundles. These short, focused video 
training clips can solve your technical questions and get you up and 
running faster than anything else. 

I have four different bundles - SAVE 30% when compared to buying 
each tutorial separately! 

�●     My Favorite Final Cut Pro Tutorials
�●     Video Compression
�●     Soundtrack Pro Bundle #1
�●     Soundtrack Pro Bundle #2

With 50 tutorials available, you can find the complete list of my video tutorials here.

You can find the complete list of my video bundles here -- SAVE 30%!

With more than 50 titles to choose from, and priced at only $4.99 each, there's sure to be at least 
a couple that can help you solve the problems you're having. Each title runs 5-10 minutes and 
can be downloaded instantly. 

More titles coming every month! Take a look and order today! 

[ Go to Top. ] 

http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/training/online_bundles.html
http://www.larryjordan.biz/training/online_tutorials.html


TECHNIQUE: THOSE AMAZING ANGLE BRACKETS

Eric Mittan, Chief Editor at WSIL-TV, sent me this great set of tips:

My favorite keyboard shortcuts are those that are contextual. The function of the 
keys in question change in the context of what task is being performed, or what 
item is selected, or what tool is chosen in order to get a different, if slightly related 
result.

The angle bracket keys are a perfect example. While technically, they are the 
period and comma key, its easier to think of them in terms of the angle brackets, 
as the brackets point in the direction the action will take.

With the default selection tool chosen, highlight a clip in the timeline and press the 
angle left angle bracket key, or comma. As long as there is room for the clip to 
move on the timeline without colliding with another clip, the clip will move to the 
left by 1 frame for each time you use it. The right angle bracket (period) does the 
same in the other direction. its a very precise way of adjusting clip placement on 
the timeline.

But that's not all! Now select the slip tool. With the same clip highlighted, press the 
left angle bracket key. The clip remains in the same place in the timeline, but now 
the clip has been "slipped" by one frame backward. The right bracket does the 
same one frame at a time forward. This trick can be ESPECIALLY useful if you're 
working with a piece of live captured video that may not be in sync with the audio 
that was captured at the same time. By fine-tuning a frame at 
time, you can achieve much more precise results.

For even more context specific uses, try using the angle brackets to "slide" a clip 
by single-frame increments using the slide, tool. Trimming or moving an edit point? 
With an edit point selected, the angle bracket keys move the edit point in single-
frame increments, whether you've selected just the in point of one clip, the out 
point of one clip, or the adjacent in and out points of two clips.

Larry replies: Thanks, Eric! These are great.

UPDATE - Dec. 28, 2009

Loren Miller adds:

I enjoyed Eric Mittan's recent discovery of the coolness of the Angle Brackets in 
FCP.

He should also be aware the same capabilities, from Trim, to Slip and Slide with 
those tools selected, to Clip Move when a clip is selected, are available using the 
Square Brackets as well! So all the brackets are now "live!" This is also covered in 
the FCP manual.

A couple of kickers of recent vintage. In FCP 7, you can actually slip and slide a 
clip with transiitons attached at one or both ends, limited only by available media...
watching these slide with the clip is unearthly! This can be a major timesaver.

As with Square Brackets, you can multiply bracket actions by holding down Shift 
and the action will increase by however many frames you've plugged into your 
Final Cut Pro > User Preferences > Editing pane (the default is 5 frames).

http://emittan.com/


Larry replies: Loren, these, too, are very cool ideas. Thanks! 

[ Go to Top. ] 

TECHNIQUE: COMPRESSOR PROBLEM WITH FCP 7

Chris Roberts first alerted me to this issue.When using Compressor on Final Cut Pro 7. When 
multiple users are using the same computer using different log-ins, if editor one submits a batch 
through Compressor, waits for the job to finish, then logs out, when the second editor logs in and 
submits a job to Compressor, they will get a "Share Failure" error.

This error is caused by Compressor not understanding that a different user has logged in.

There are two solutions:

1. After the first editor is done, restart your system and log in as a new user. The 
restart reset everything so it works properly.

2. As Jonathan Eric Tyrrell pointed out to Chris, a second workaround is that 
when the second editor has logged in and submitted a job, they are prompted to 
Reset Compressor.

Resetting Compressor in this dialog also fixes this problem.

For my part, I run into this error several times a week. I've just gotten into the habit of restarting 
each time an editor logs out at the end of their shift.

[ Go to Top. ] 



COMPARING RED WITH DSLR CAMERAS

Tony Mendoza's first line got my attention:

Greetings from Afghanistan,

My name is Tony Mendoza. I'm a soldier currently deployed to Afghanistan and a 
big fan of your show. I had two questions in regards to the new DSLR cameras 
shooting HD compared to the RED camera. I'll try to keep it simple.

From what I understand RED shoots a very high resolution (4K) image. But from 
what I read so far, some of the new DSLR cameras shooting 1080p capture 
images at the same frame size as 35mm film.

Question 1: Are the image quality of both the RED and the top of the line DSLR 
cameras the same or close to? (i.e. to show on a theater screen)

Question 2: The 35mm frame size the DSLR says it shoots, is that equivalent to 
the 35mm I shot with my mother's still camera when I was 12 or is it equivalent to 
a motion picture camera (Arri) or are the film stocks pretty much the same size. 
Thus the 35mm.

Larry replies: These are two formats that I don't shoot, so I farmed Tony's question out to my two 
resident experts on RED and codecs -- Philip Hodgetts and Noah Kadner. Here are their 
replies.

Philip writes:

The answers to both are somewhat interrelated. I think the answer to 1) is that 
certainly RED is being used for many motion picture releases (Ché immediately 
comes to mind) and TV series. The DSLRs are being used occasionally for web 
series but no movie or TV production other than experimental shots.

RED uses a compressed RAW signal that maintains all the information from the 
camera. The DSLR compress to highly compressed H.264 "long GOP" (technically 
its not, but close enough). They cannot be compared for workflow quality. RED 
puts 4x the pixels in the file and keeps each frame an intact entity.

Neither are yet "equal" to film stocks. In some respects RED is better than film 
stock - with digital 2K or 4K project much more data ends up on the screen than 
from film projection, because of the resolution killing inter-neg and inter-pos 
processes that film goes through (even just for distribution) and because the film is 
not projected with each frame perfectly aligned (gate weave) even the resolution 
that is inherent in a single film frame is slightly compromised in viewing by this 
gate weave.

Noah writes:

1- Not the same. The DSLR cameras definitely shoot gorgeously shallow DOF 
with those Canon lenses, but the codec employed is far more compressed/lower 
color and gamma fidelity next to a RED.

2- Depends on the camera. They all shoot at maximum a 1920x1080p frame- less 
than half of the frame size shot by a RED or the 2K frame typically scanned off a 



much higher resolution 35mm frame.

But anyway, these are kind of dancing-around-the-issue questions. The real 
question should be: can I shoot feature quality footage with one of these cameras. 
With the Canon 5D Mark II or 7D, good lenses, and, of course, good 
cinematography -- sure.

Larry adds: Thanks, Philip and Noah, for your help with this!

UPDATE - Dec. 27, 2009

Anthony Burokas writes:

The two commenters on the COMPARING RED WITH DSLR CAMERAS article 
provided little insight. 

This article here provides incredible depth and says, in essence, DSLR cameras 
lack the low-pass filter and true resolution to provide even HD images, let-alone 
real 3-4k resolution. RED does. They both suffer rolling shutter CMOS distortions - 
covered numerous times on my blog.

Larry replies: Thanks, Anthony, for writing. I am always grateful when readers supply more 
information. Here's the link that Anthony referenced: www.dvxuser.com/articles/article.php/20.

[ Go to Top. ] 

Larry is On The Road in January 

I am training and speaking all over the country in January. Come visit one of my seminars near 
you:

Jan. 11 - Miami, FL. Seminar: PowerUP Tools for a Down Economy. Learn how 
to get more done with less effort, and save money -- this seminar emphasizes 
visual effects and audio. 

Jan. 16 - Dallas, TX. Seminar: PowerUP Tools for a Down Economy. Learn how 
to get more done with less effort, and save money -- this seminar emphasizes 
visual effects and audio.

Jan. 17 - Austin, TX. InFocus Video Event. Larry is doing a special four-hour 
presentation at this event geared toward wedding videographers -- and at a 
GREAT price! 

Jan. 29-30 - Los Angeles, CA. Assn. of Video Professionals. Save 10% use 
promo code: FCPGURU. Larry is doing two in-depth presentations on Final Cut 
Studio. 

[ Go to Top. ] 

TECHNIQUE: CREATING A VIGNETTE

http://www.dvxuser.com/articles/article.php/20
http://www.larryjordan.biz/seminars
http://www.larryjordan.biz/seminars
http://www.infocusvideoevent.com/blog/2009/09/larry-jordan-fcp-workshop-50-for-infocus-attendees-75-for-everyone-else-topics-and-registration-info-bottom-of-post.html
http://www.aovpros.com/conference


This technique grew out of a discussion with Daniel Carrion on how to create a vignette in FCP.

A vignette is a shadow around the edges of your image that draws your eye into the center of the 
frame. This technique has been used for the last hundred years to emphasize one part of an 
image more than another. In this tutorial, I'm creating a more dramatic effect than I would 
normally use, because it makes the effect easier to see. 

Fortunately, this effect is easy to create -- it just takes two layers. Here's how.

1. Place the video you want to add the vignette effect to on V1.

2. Hold Shift+Option and drag a copy of the V1 clip up to the V2 track. (Shift constrains the clip 
so it only moves vertically, while Option makes a copy of it.)



3. Double-click the V1 clip to load it into the Viewer and reduce it's opacity to around 50%. If you 
want the vignette to be more obvious, lower the opacity. If you want the effect to be more subtle 
raise it.

4. Select the V2 clip. Then, apply the Effect > Video Filters > Matte > Mask Shape filter.

5. Double-click the V2 clip to load it into the Viewer, click the Filters tab and change the Shape 
to Oval.

6. Adjust the Horizontal Scale and Vertical Scale sliders until you have the size effect you 
want. In this example, I used a horizontal scale of 101, and a vertical scale of 86.

7. Make sure the V2 clip is still selected and apply the Effects > Video Filters > Matte > Mask 
Feather.

8. If necessary, double-click the V2 clip to load it into the Viewer, click the Filters tab, and adjust 
the Soft setting of the Mask Feather filter to get the effect you want. In this case, I set it to 100% 
for maximum softness.



Here's the finished effect and settings.

Feel free to experiment with different mask shapes, V1 opacity levels, and amounts of mask 
feathering.

UPDATE - Jan. 4, 2009

Brian Galford adds:

I just tried the vignetting technique you recommended and realized that if you 
make the circle small enough, this is a perfect way—perhaps the way already in 
use by your readers— to highlight small objects and people—for example, an 
individual player, in a sports field filled with teammates or opposing players. You 
then use the "center" button repeatedly adding keyframes, to move the circle 
around with the player you wish to highlight.

Larry replies: Brian, you are exactly correct. This is a great technique for spotlighting something. 

[ Go to Top. ] 

TECHNIQUE: GENERATING A GRADIENT

This technique started with a note from Patrick Bronte:

I am currently working my way through your training series - FCP 6 Essential 
Editing. Thank you so much for putting together such an easy to follow set of 
tutorials. Without it I would still be searching for someone to teach me.

One quick question - how do you generate the gradient to apply to an overlay? I 
am following the tutorial - Composite Mode - Enhancing Landscapes.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?cPath=21&products_id=56
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?cPath=21&products_id=56


Larry replies: The process of creating a gradient is easy. However, the menu is almost 
impossible to find:

1. In the Video tab of the Viewer, go to the lower right corner and click the small 
menu with the letter A on it. (This is called the Generator menu.)

2. Select Render > Gradient.

3. Click the Controls tab in the Viewer and change the gradient type as 
necessary. For example, to have the gradient shade from black to white from top 
to bottom, select Horizontal from Bottom to Top.

At this point, your gradient is now a clip in the Viewer that you can manipulate like 
any other clip.

Extra credit

* You can also access this same menu from the Effects tab in the Browser.



* The duration of a generated clip is determined by the setting in Final Cut Pro > 
User Preferences > Editing tab -- Still/Freeze Duration.

* If you want a gradient using colors other than black and white, change your 
selection in the Generator menu to Render > Custom Gradient.
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TROUBLE-SHOOTING: TOO MANY HARD DRIVES 

David Tindale sent this in:



  
  
  
  
  

Thanks for the newsletters -- always informative and a good read.

I have a problem with a project I'm working on, I have been having intermittent 
problems when trying to render, FCP attempts to render and then throws up a File 
Error error message saying it can't complete it's work.

Any ideas?

Larry replies: My first thought was that David needed to Repair Permissions on his boot disk. 
However, what his initial message didn't tell me was that he had a NUMBER of hard drives 
attached to his system, as his second message indicates. David writes: 

I've sorted my File Error problem with the kind assistance of Dan from Mac Tech 
Support. It seems that when you have more than one external HDD attached to 
your computer, a "clogging" of the Firewire Bus can occur.

The remedy is to turn off and disconnect all non-essential drives, i.e. any drive not 
necessary for editing.

Shut down your computer, then restart with only the required drives connected. All 
up it took about 10 minutes to fix a very frustrating problem.

Thanks for your time and suggestions.

Larry continues: This points up a really big issue -- the more FireWire drives you add to your 
system, the slower it goes. My personal limit is five. After that, the hard drives spend so much 
time talking to each other, that they forget to send data to the computer.

Here are some other hard disk tips you can consider:

* Limit the number of hard drives you have connected to your system.  
* If you have FireWire 800 drives, don't connect them via FireWire 400, it slows 
them down.  
* Connecting a FireWire 400 drive to your computer slows down any attached 
FireWire 800 drives 
* Keep plenty of free space on your hard drive - I recommend 20%

[ Go to Top. ] 

TROUBLE-SHOOTING HARD DISK PROBLEMS WITH  
SNOW LEOPARD

Adam Connell sent me this:

A friend of mine's laptop was refusing to boot. It was a 2007 MacBook pro. They 
asked if I could check it out, which I did en route home the other night. We were 
ready to try and reformat the hard disk but she wanted to save a few photos in her 
home folder. 

With the machine refusing to boot, and target disk mode with my MacBook not 
able to access it, and without an external hard disk to make a quick install of OS X 
onto to try and access the disk I was worried, as obviously I could not remove her 
drive and try and plug it into my macpro easily. 



  
  
  
  
  

But, she happened to have an install disc for 10.6, which due to it's small footprint, 
using my machine I was able to install a copy onto my 16 GB flash drive. I was 
then able to boot her laptop from that and save her files. Now I've decided that for 
salvaging any machine that is refusing to boot from it's internal drive having a 
spare, putting a fresh install (it is only 6 GB) for OS X on a flash drive in your 
pocket is great. Especially as removing many mac hard drives to put into another 
machine like the mac pro is not easy. 

Is this a tool worthy of Larry's toolbox?

Larry replies: VERY cool! Two gold stars for this one!

Adam adds: 

No worries, it was very easy. Just format the flash drive with journaling on in 
Utilities > Disk Utility and then when running the installer app, select the option 
"show all hard disks"

[ Go to Top. ] 

A CONTRARY OPINION

In my September newsletter, I took Apple to task for removing both eSATA and FireWire 400 
ports on their latest MacBook Pro laptops. (You can read the article here.)

Jim Reilly, from Scotland, however, sent me a differing opinion:

Going against the grain slightly regarding your latest Apple peeve. I think Apple 
have looked at their laptop range and decided if you are going to edit video on one 
of our laptops, why would you do it on anything else other than a MacBook Pro? 
(And on its biggest and best screen). 

Let's face it if you found yourself out in the field without an external video monitor 
and you wanted a fighting chance of getting a piece finished and looking half way 
decent they would be absolutely right. 

But Apple isn't off the hook just quite yet because this brings me onto my Apple 
peeve. Why, when they brought out their new LED 24" Cinema Display did Apple 
make no effort whatsoever to produce a reasonably priced DVI to Mini Display 
Port adaptor? In one fell swoop thousands of customers who purchased a 17" 
MacBook Pro as late as December 2008 or a Mac Pro as late as Feb 2009 were 
excluded from acquiring this new display device!

Even the new MacBook with it's inadequate choice of Ports has a Mini Display 
Port which makes the situation even more nuts.

What an own goal, a decision that's a major revenue killer. Alternatives? Well one 
third party has produced an adaptor but it costs nearly $200! and believe it or not 
there are other display devices out there that are not only better but cost about the 
same, so, as we say over here in Scotland "Hell mend them!"

Larry adds: Yup. The lack of an adaptor on two of my G-5 towers prevented me from buying 
more of these monitors. The monitor looks great, but its quite limited in terms of the computers it 
can connect to.

http://www.larryjordan.biz/articles/lj_macbookpro.html
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TECHNIQUE: IMPROVING SOUND QUALITY

Jan Bliddal writes:

I normally do all my recording using a Canon XH-1A with a Beyerdynamic MC86 
shotgun mike (personal projects only) But I am now also using the new iPod Nano 
to record math lectures and it is surprising how much the right use of soundtrack 
pro can improve the general sound-level of those recordings. It records around -30 
dB in a normal classroom.

Using the new Normalizing setting in SoundTrack Pro -12DB then reducing noise 
based on a noise-print of the ambient noise. The last step is to use you limiter 
tutorials to kill everything above -3 dB. I know I am using it way beyond what you 
recommends in your tutorial, but with the limited sound-level and quality of the tiny 
mic on the iPod Nano it really does improve the audio quite a lot.

Larry adds: Thanks for this tip!
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DISCUSSION: PICKING THE RIGHT VIDEO FORMAT

Jim Mitchell sent the following email with another great first line:

I just purchased yet another copy of your FCP 6 editing essentials - this time for a 
FCP prison program at a women's correctional facility in Las Vegas, NV. See, 
you're popular just about every where! Between FCP 5 and 6, that's about 9 of 
your books total for employees and such.

Question: We are ready to commence digitizing thousands of hours of broadcast 
video. First step is to take the composite analog portion up to SDI. Is FCP 5 and 6 
truly loss-less going in and coming out? I know it is touted as being 10-bit 
uncompressed but then Sony says their digibeta is also 10-bit uncompressed but it 
is in fact compressed and surely not loss-less. 

Meanwhile, the old Scotch 1" tape is fading fast. In preliminary tests, the 379 stock 
is holding up surprisingly well and is very quiet with not too much noise and 
artifacting but the 480 XST stock that Scotch last manufactured and touted as their 
"hot - fine particle oxide" stock is shedding like a mangy dog in Summer. 
Remember when the tape reps said that you had to turn the reels every six 
months to eliminate creep and print-through? Seems I should have listened closer 
to that sound advice.

Larry replies: Jim, thanks for writing. 

"Loss-less" is SUCH a squiggly term. Loss is caused by the codec, not FCP. FCP does not alter 
your footage. So in that sense, its loss-less. Bid-depth and other artifacts are NOT FCP related, 
but codec-related.



On the other hand, ALL video formats use some form of compression - either in compression, 
color sub-sampling, color space conversion or other weirdness.

On the other, other hand, you could capture everything to Animation - which IS loss-less 
(mostly), but can't be played in real-time and creates enormous file sizes.

On the other, other, other hand - most of today's video formats, even those that are compressed, 
look better than your source footage from 1" or 2".

On the other, other, other, other hand -- if you want something that can be archived for a while, 
supports 10-bit video, and is used by video archivists around the world, here's what I would 
recommend.

Use Photo-JPEG to store your images. When set at 100%, Photo-JPEG is compressed from a 
data point of view (think ZIP files) but UNcompressed from a video image point of view.

My son is a digital archivist and in conversations with Philip Hodgetts, my son, and other experts 
I am convinced that the best long-term storage solution is Photo-JPEG. 

So the workflow is capture your video as 10-bit uncompressed and don't sweat the 4:2:2 chroma 
sub-sampling. Then, after capture, transcode into Photo-JPEG using Compressor - or other 
compression tool - and archive the resulting file.

Smaller file size, great quality, no image loss.

UPDATE - Dec. 28, 2009

Marcus Pun writes:

Jim, you may try storing your 1-inch reels as well as all the other reels in a low 
humidity environment, no more than 25%, and about 60 degrees F or so for a long 
period of time before playing. 

A client of mine involved in archiving thousands of30+ yr-old 3/4 u-matics and a 
small number of 1-inch reels has had some success with reels that were stored for 
more than 6 months in their new and much tape-friendlier environment. A number 
of tapes that would have shed oxide prior to storage were less prone to shed and 
were more playable after about 1 year in the above storage conditions. 

There is also a "baking" method to tape restoration that should only be done by 
experts.

Additionally, your equipment should be in a low humidity environment. Moisture in 
the air causes stiction and other problems with tape transport. 

Finally, if there is a difference between storage and playback environments the 
tapes need to acclimate for at least a few hours to the different temp and humidity 
conditions of the playback environment.

Good background info can be obtained from here:

http://www.loc.gov/film/tvstudy.html

...and from Jim Wheeler:

http://www.loc.gov/film/tvstudy.html


http://www.wheelertapeforensics.com/

Jim is a past engineer at Ampex, probably the go-to guy in the world. 

Afterthought, beware of the 3M 459 stock with the padded reels. The glue for 
those reels leeks onto the tape. There are services available that will clean the 
glue off. I spent a good amount of time in the 80's pulling off the old padded 
flanges and putting on new ones. 

Larry replies: Marcus, this is GREAT information. Thanks for sharing! 

UPDATE - JAN. 3. 2010

C. Park Stewart, of VideoPark, adds:

Here are some comments on digitizing old video and picking the right format. I 
have restored several quad and 1" VTRs and offer archiving as a service.

Analog formats do not use compression. Bandwidth limits, yes but no 
compression. D-1, D-2 and D-3 do not use compression. D-6 was an 
uncompressed HD recorder made by Philips/Toshiba (with 34 heads on the 
scanner!).

Sony never said Digital Betacam was uncompressed. It is around 2.2:1 
compression very well done.

The Library of Congress National Audio-Visual Conservation Center in Culpeper, 
VA is using JPEG2000 as their compression format and recording to LTO tape.

I suggest migrating the video into files and put them to LTO tape. That is 15 times 
cheaper than recording the video to Digital Betacam, for example, due to the cost 
of tape.

30 year old video doesn't need to be captured uncompressed. Cameras then had 
low resolution and poor chroma response. Poor image quality isn't the fault of the 
tape system but of the imaging device. ProRes may be a contender or the 
JPEG2000 codec. Try compressing old video with DV25. You may find that 
acceptable.

If tape is sticky or shedding, bake it for 130 degrees for 12 hours.

Larry replies: Thanks, Park. 
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MOVING BETWEEN PAL, NTSC, AND HD

Over the last four months, Pia Sawhney and I had a long email chat about video formats. Here 
are the highlights. Pia writes:

My cinematographer filmed in Africa two weeks ago on a Canon XHA1 using the 
1080 setting at 30 frames. This is still considered progressive on Canon, which I 
didn't realize at the time, but from what I've been reading - the capture and edit still 

http://www.wheelertapeforensics.com/


uses a 60i setting for the most part - am I right about this? Which codec would you 
suggest using for capture in this circumstance?

Larry replies: With this camera, try an Easy Setup of HDV 1080p/30 FireWire Basic first, if that 
doesn't work, use HDV 1080i/60.

ASSUMING the following are true, working with native HDV is fine:

1. You are capturing HDV natively using FireWire and you do not plan to recapture 
it 
2. You are not planning to deliver this program to broadcast 
3. You are not planning on major effects.

If true, keep your sequence settings set to HDV 1080i/60.

If you plan to integrate other video formats, it would be better to convert the HDV to ProRes 422 
during capture. Faster rendering, higher quality output, and ability to output to multiple tape 
formats. I would recommend this option. The easy setup is HDV to ProRes 422.

Pia continues: 

I do want to have the option of delivering this project to broadcasters; and so, 
perhaps an upgrade to ProRes 422 is, in fact, the right option. The film will have 
effects, and additionally, there's a chance I may have to get additional footage 
from the field which would mean integrating other formats.

Larry replies: With HDV, ProRes 422 should be fine.

If you are outputting for broadcast, I don't know any broadcaster that accepts HDV tape - you'll 
need to find out what tape formats they support.

The conversion between ProRes and your ultimate format is generally done either during final 
compression or during ingest using the capture card.

AS ALWAYS, test your entire workflow before committing. 

Pia continues:

I'm capturing footage on ProRes 422 and it looks great. But I've been trying to 
output to DVD, and I'm getting all tangled up in compression. Any clues on how I 
might send ProRes footage to DVD? Once I master this workflow, I'll be ready to 
start -good news, for sure.

Larry replies: You have several options. Keep in mind that DVDs are ALL SD, not HD. This 
means that you need to down-convert your HD footage to SD before burning to a DVD. Blu-ray 
Discs are HD, but can't be created in DVD Studio Pro.

If all you need to do is burn ONE sequence to DVD, without any fancy menus, use File > Share 
> DVD from within Final Cut Pro. 

If you need to create a DVD with menus:

1.  Use File > Export > QuickTime movie.
2.  Create a self-contained movie using your ProRes format.
3.  Bring that ProRes file into Compressor and apply the DVD Best Quality setting that most 

closely matches the TOTAL length of all your videos. This process will down-convert your 



HD footage to SD.
4.  Bring the now-compressed MPEG files into DVD Studio Pro and author your DVD as 

normal.

Pia then sent another question:

You're quickly becoming my spiritual master as I move forward on this 
documentary production. :) Given budget constraints, we have had to shoot on DV 
and are now going to possibly have to shoot on PAL. I had a question -- is it 
possible to shoot on HD in PAL and then convert the footage back to NTSC, and 
keep HD quality? I am still editing in ProRes on HD -- and that looks just 
spectacular so I'm probably going to just up-res DV if need be. its fine with the 
story because I'm co-producing these segments with African artists. (Actually PAL 
may be shot in Copenhagen next week, so there's really no excuse not to have 
these pictures in HD, which is why I certainly welcome any suggestions! :))

Larry concludes: Thanks for your gracious words!

You about to give yourself some very tricky problems in your edit.

1. Can you shoot PAL and keep HD quality? No. PAL is an SD format.

2. Can you shoot PAL and convert to NTSC? Yes, however, the quality and 
smoothness of movement will not be as good as if you shot NTSC directly.

3. Can you convert PAL to NTSC? Yes, however unless you spend a lot of money, 
the conversion takes a lot of time - 4-8 times longer than real time.

4. Can you shoot HD at 50 frames a second and edit it with HD shot at 60 frames 
per second? Yes, though transcoding to ProRes at the same frame rate before 
editing will save a lot of headache.

The key thing is to be SURE of your terms, and the terms your remote crews are using. PAL is 
standard-def. NTSC is standard-def. HD is high-def. Be sure they are shooting the same image 
size you are - 1080 or 720. Frame rates can be converted more easily than image size. It is easy 
to go from HD to SD, it is NOT easy to go from SD to HD.

UPDATE - Dec. 28, 2009

Matt Davis writes:

I think the questioner actually meant shooting HD at PAL frame rates (25p or 50i) 
then shifting frame rates to NTSC (24, 29.97 and so on).

its the start of a workflow I've been experimenting with for creating the best NTSC 
experience from a PAL project (even if it was filmed in HD), to whit:

�●     Film at 25fps at choice of resolution
�●     Edit at native rate, export master edit as Audio and Video files
�●     Change the header information to make the 25fps movie 24fps (actually 

23.97) and cleanly scale to SD
�●     Change the audio to fit the new timebase (4%) either accepting slight pitch 

shift or processing it to achieve time without pitch shift
�●     Encode to multplexed format of choice (in other words, reunite video and 

audio into one file

Therefore using the 3:2 pulldown technique to get HD at PAL rates onto an NTSC 



screen in such a way that someone used to seeing 3:2 pulldown would not feel 
anything untoward has been done to the frame rate.

Larry replies: Thanks, Matt. 

[ Go to Top. ] 

PASSING THOUGHTS

A series of quick mentions of interesting products.

Joseph Bailey asks:

Calibrated{Q} MP4-EX Import for OSX for the PMW-EX1 from Calibrated 
Software.

Does this software work as well as advertised?

Mike Horton replies: Don't know this app except from the demo Tim Dashwood did at the 
SuperMeet, but he sings its praises.

www.dvinfo.net/forum/sony-xdcam-ex-cinealta/234143-calibrated-q-mp4-ex-import-
xdcam-ex.html

UPDATE - Dec. 30, 2009

Ron Hoeltge adds:

Let me add my two cents:

I shoot the EX1 and have gotten into a terrible habit of doing nightly drag-and-drop 
Finder copies of the video files in the BPAV folder on SxS card via my MacBook 
Pro's ExpressCard slot, strictly as matter of a convenience when I'm tired of hiking 
and dragging video gear around. The native Sony .MP4 files had be reviewed 
using VLC since QuickTime Pro v7 wouldn't play them. (I could use the Sony 
software, but it lacks any decent Mac user interface. Later, these files are moved 
to my MacPro via ethernet, but cannot be imported into FCP without transcoding, 
again because of the MP4 issue. And because they aren't in the native Sony card 
file sequence, they are ignored by the Sony software. 

Calibrated{Q} MP4-EX Import for OSX for the PMW-EX1 lets me review these files 
in QuickTime, and import them directly into FCP projects, even though they are 
technically "orphaned" from the native folder format of the SxS card. This is, of 
course, exactly what they advertise it will do. I can even preview files within the 
Finder windows, or use Quick Look to play them. The $79 price is easily worth it to 
me to eliminate the heavy-handed and obtuse Sony software, which they 
infrequently update without notifying anyone who bought their multi-thousand 
dollar cams.

A new issue: Along comes Snow Leopard, which when installed, promptly breaks 
the Sony EX Transfer software for transcoding these .MP4 video files the correct 
(Sony's) way. There are forum posts saying there have been adequate updates 
made that now allow it, and almost as many saying they still have problems with it. 

http://www.calibratedsoftware.com/
http://www.calibratedsoftware.com/
http://www.dvinfo.net/forum/sony-xdcam-ex-cinealta/234143-calibrated-q-mp4-ex-import-xdcam-ex.html
http://www.dvinfo.net/forum/sony-xdcam-ex-cinealta/234143-calibrated-q-mp4-ex-import-xdcam-ex.html
http://www.calibratedsoftware.com/


Sony officially says its a problem they are aware of, but cannot predict when it will 
be fully resolved for Snow Leopard users.

Calibrated{Q} MP4-EX Import for OSX for the PMW-EX1 should allow my lazy-
man's way of taking files from the SxS card under Snow Leopard, previewing them 
in QuickTime (without launching players or other software), moving them between 
Macs and getting them into FCP without worrying about in what future year Sony 
will begin to seriously support Mac user's who bought the EX-cellent series of 
Sony cams.

Larry replies: Thanks, Ron, for the update. I really appreciate it. 

Looking for a list of third-party effects and content for FCS? Check out this page on Apple's 
website:

www.apple.com/finalcutstudio/resources/plugins.html

(Thanks, Nicolas Nilsen, for the tip!)

Alice Kostenko asks:

Super quick Q for you. One of my clients wants to give me Mpeg2 video to edit. 
Do you know how to properly import it into Final Cut? I tried importing one of my 
own MPEG files but they act wired in FCP.

Larry replies: Convert them from MPEG2 into DV or DVCPRO-50 which is a video format FCP 
can edit.

Use MPEG StreamClip (Square D software) or DVDxDV to do so.

[ Go to Top. ] 

READER MAIL

GETTING SLO-MO IMAGES TO LOOK BETTER

Dave Pastor writes:

I am just a serious enthusiast when it comes to videography. I don't do any 
professional recording. I use Final Cut Studio and I probably need to upgrade. I 
purchased it back in 05. 

Anyway my question is that I mostly find myself recording games for a weekend 
warrior flag football league. I put together a highlight DVD for the players to 
purchase at the end of the season. I use a Canon XL-1 and record on mini DV 
tapes. I am really disappointed in the quality of the footage. I am disappointed 
because the playback is jittery and when I slo-mo some nice catches everything 
looks??interlaced?? 

http://www.calibratedsoftware.com/
http://www.apple.com/finalcutstudio/resources/plugins.html
http://www.squared5.com/
http://www.dvdxdv.com/


My question is am I not recording things right, capturing things right or is that just 
the best its gonna be and I need to purchase a high def camera?

Larry replies: There are three possible answers here: Yes, No, and Maybe.

All DVDs are standard-def - so shooting in standard-def makes perfect sense. So, do you NEED 
to purchase an HD camera? No.

If you plan to distribute your work on Blu-ray Disc, which is HD, your SD footage will look very 
soft and grainy. So, do you NEED to purchase an HD camera? Yes.

However, I suspect the answer lies in-between. If you compare your slo-mo with what the 
networks create, yours will look jittery and somewhat soft. That's because you are working with a 
$3,000 camera, while the networks are using $150,000 cameras, combined with SERIOUS post-
production gear. You could replicate the effect for about $150,000 using a combination of 
hardware and software. So, do you NEED to purchase an HD camera? Maybe.

To make things look better, try changing your speed in the following increments: 50%, 25%, 
20%, 10% or 5%. Lo-motion percentages that yield the best results are those that divide evenly 
into 100. 

You can also consider buying, or renting, a camera that shoots a variable frame rates. Video that 
is shot in slow-motion always looks better than video that is slowed down in post-production.

That should fix the jitter. 

All NTSC video is interlaced, that can't be avoided. However, shooting a progressive image, 
which the Canon camera supports, will help a lot.

So, do you need to purchase an HD camera? Probably not - shoot progressive and only work 
with certain slo-mo speeds and things should improve.

UPDATE - Jan. 2, 2010

Tore Jonssen adds:

Making movies for a lot of oil and offshore companies, I have recorded lots and 
lots of hours filming small scale model tests, often having to slow footage down to 
as much as 15% of real life speed. The FCP plugin Twixtor has given me great, 
smooth slo-mos from interlaced SD footage where FCP couldn't. Great plugin, the 
only downside is you'll have to expect a LOT of rendering. 

Larry replies: Thanks, Tore, for sharing this. 

[ Go to Top. ] 

WHAT"S THE PROBLEM HERE?

Louise Fleming writes:

I am working in FCP - 5.1 with a Mac OS X 10.4 - my media is on a Glyph hard 
drive/GT 050Q. Up to this point everything was operating OK - But then in the 

http://www.revisionfx.com/products/twixtor/


middle of editing, FCP started to freeze - along with the turn of the wheel. 
 
I tried several times to reboot and the same problem occurred. Admittedly I turned 
off the Glyph hard drive without going to the Finder and ejecting it [so that it turns 
off by itself on the apple desktop]. 
 
Now when I turn on my apple, pull up FCP - I get the error message "Glyph hard 
drive" missing? so the Glyph icon does not appear on the desktop - so I can't 
work. 

Does this mean that my media is corrupted? What are my options? Would a loose 
firewire cable [from Apple to the drive] cause this problem?

Larry replies: Louise, first, while a loose FireWire cable will cause problems, my first suspicion is 
that your problem lines elsewhere.

FCP remembers your scratch disks when you quit the application. If it keeps asking for a hard 
drive that isn't there, go to Final Cut Pro > System Settings and reset your scratch disks so 
they point to the correct hard drives. Resetting your scratch disks will make the error message 
you mentioned go away.

Note: You can tell if there's a problem, because if FCP can't find a scratch disk, it 
will add the word "Missing" to the path name of the drive. 

Next, here's an article I wrote on trouble-shooting your system. After you finish reading this 
newsletter, do a Safe Boot on your system. The article will explain how.

However, the bigger problem is that the hard disk is not appearing on your desktop. ALWAYS 
eject a hard drive from the Finder before disconnecting any cables or turning it off. Otherwise, 
the disk directory - the list of files stored on your hard drive - is not updated. This can cause a 
hard drive to become very unstable.

The rule is hard drives are the first thing you turn on - before the computer gets powered up - 
and the last thing you turn off.

As budget allows, a really good utility that repairs hard disks that are starting to get flaky is 
Alsoft's Disk Warrior X. I tend to run it on all my hard drives about once a month or so. It is 
excellent at fixing disk problems, as well.

http://www.larryjordan.biz/articles/lj_trouble.html
http://www.alsoft.com/
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MULTICLIP QUIRK

Ian Hart writes:

I've been using FCP 7 for a month now, mainly doing Multiclip edits from a 2-
camera coverage of educational material. My two angles are normally called 
"Camera_1" and "Camera_2" and the Multiclip is named (by default) "Camera_1 
[1] Multiclip 1". The default Sequence name is "Sequence 1" and I normally 
rename it something more meaningful. However whenever I turn my back I find 
that FCP7 has renamed the sequence to the roll name of the first clip in the 
sequence, e.g. "Camera_1". I can change the sequence name back but it reverts 
to FCP's quirky preference.

This is hardly a project-breaker, but it is very irritating.

Larry replies: Hmmmm... Interesting.

I haven't noticed this. Try trashing FCP preferences. (Here's an article that explains how.) If that 
fixes this problem, great. If not, then we have found a quirk!

[ Go to Top. ] 

KILLING ECHOES

David Fortin writes:

I'm wondering if you might have covered this in one of your tutorials and/or could 
direct me to a resource for this info. (I've searched other forums and things, but 
you never know where the info is coming from, and if the information is reliable. 
After reading your monthly newsletter, meeting you in person at a Boston FCPUG 
meeting and purchasing a few small tutorials, I can count on you to explain it 
efficiently and reliably. And, to say, "I don't know", if you don't!)

In shooting a documentary with 20+ interviews, 4 of them ended up in an empty 
chapel with wooden walls, hard floors and wooden pews. As you can imagine the 
sound is not that great. And I think that me hiding the TRAM lav under collars and 
the like, didn't help it any. its shot with a Sony EX-1. The lighting is pretty good, 
which I think makes the audio "sound" even worse, since the image is so nice.

Do you have a resource I can turn to or tutorial I can purchase that might cover 
how to reduce the echo a little? I know there probably isn't anything I can do to get 
rid of it, but any help will be good. The content of the interviews were great but the 
sound quality pales in comparison to the rest of the interviews.

Larry replies: Prior to getting Brandon's email (see below), this was one of my two least favorite 
types of emails, because I don't have good news at this point. (My least favorite is when 
someone writes asking if I know where there's any work. I hate saying no.) 

I don't know of any technology that will remove or reduce echoes. All noise reduction filters work 
by manipulating frequencies - however, the frequency of the echo is the same as the frequency 

http://www.larryjordan.biz/articles/lj_trouble.html


of the voice, which means that whatever you do to the echo is also done to the voice.

You can play a bit with the lower frequencies to try to warm things up a bit, but, as Hollywood 
has discovered, if you need to get rid of echoes, your best option is to re-record.

its too late now, but what I've done in the past for interviews like this is hang heavy sound-
blankets just outside the range of the camera to kill some of the echoes. Also, lavalieres are 
notorious for picking up echoes. A short-shotgun mic is much better for these situations.

UPDATE - Jan. 2, 2010

Brandon Sommers sent this in:

I recently discovered a plug-in that does a wonderful job on echo reduction. I used 
it on a kitchen/cooking show where we should have hung blankets and it really 
reduced a lot of the echo sound:

http://www.spl.info/index.php?id=463

They have 14 day free trial

Larry replies: Brandon, this is great! I have NOT tried this, but if it helps reduce echoes, it could a 
very big help to a lot of people. Thanks! 

[ Go to Top. ] 

ZOOM YOUR ZOOMING

Simon Morton, from somewhere near London, writes:

Firstly can I say how brilliant your training videos are, very informative and very 
well taught, not to mention very amusing. Normally I loose the will to live during 
training videos, but yours are great, though my wife looks at me very strangely 
when I repeat your expressions like 'hootie- kazootie'!

Anyway, I have final cut studio 3, and really like the new "zoom in on playhead in 
timeline". However, I would love my mighty mouse trackball (scroll up) to control 
the "zoom in on playhead in timeline", and scroll down to control "zoom out on 
playhead in timeline". So basically rather that going to click a custom button in the 
button bar that I have set up, zooming in and out of the playhead can be done 
from the mouse.

P. S. In the spirit of international cooperation, can I suggest some 
cockney rhyming slang for your next training video. Here are some 
expressions you could slip into the video to keep us Brits attention:

�●     "Would you adam and eve it" = would you believe it
�●     "the button bar is your best china plate" = the button bar is your best mate/ 

friend
�●     "make sure you have your auntie Nelly set up correctly" - make sure you 

have your telly set up correctly

Larry replies: Simon, I have two Brits working here with me in the office and they were VERY 

http://www.spl.info/index.php?id=463


impressed with your Cockney rhyming slang.

To solve this puzzle, you need to assign an FCP keyboard shortcut to the Zoom In and Zoom 
Out on Playhead functions. You do this inside FCP using Tools > Keyboard manager. 

Once these functions have been assigned to a keyboard shortcut, go to the Apple logo > 
System Preferences > Keyboard & Mouse and assign that keyboard shortcut to the buttons on 
your mouse. 

Now, whenever you push that button, you'll zoom in, or out, at the location of your playhead in 
the Timeline. (Note: this shortcut is only available inside Final Cut Pro 7.) 

[ Go to Top. ] 

SOLVING SOUNDTRACK PRO PROBLEMS

Keil McLeod, from Aberdeen, Scotland, writes:

I sent FCP sequence containing tracks A1 & A2 to STP2 Multi Track Project. 
There I added one music track linked to Submix 2.

Both Submixes were set to Stereo.

Then I “Saved as” and exported the Master Mix (AIFF 16-bit 48KHs) sent to Final 
Cut Pro Sequence. The XML destination was the original FCP project with Auto 
option and the other boxes all checked.

No .aif Mix shows on A1 & A2 and my original tracks are still in place with the 
visibility lights off. All my text and motion files need rendering.

Any suggestions?

Larry replies: Several thoughts.



I have found STP 2's "Send Back to Final Cut" to be very unreliable. I don't use it. Instead, after 
saving your project file, export your mix as an AIF file (16 bit, 48 kHz), the switch to FCP and 
import it as any audio file.

Turning off visibility lights is appropriate. You want to keep all your original audio, but not hear it. 
That way, you can go back to your source and remix if you need to.

Drop the new mix at the bottom of your timeline and be sure the green visibility lights on the left 
of the Timeline for the tracks containing the mix are the only ones turned on (green).

Since you are outputting stereo, I don't see any advantage to putting your music on submix two. 
It is already mixed, so you are just adding complexity where it isn't needed.

[ Go to Top. ] 

DISCUSSION ON HD

Mike White and I had the following discussion. Mike wrote:

I do not want to use HD due to the extra time and hard drive space needed. What 
digital camcorder do you recommend? Which is better mini tapes, hard drive, or 
flash drive? I heard that you can only do precise editing with mini tapes. I like a 
viewfinder. The newer ones just have an LCD screen, which is hard to see in 
bright sun.

Larry replies: Mike, thanks for writing.

Almost all new cameras sold are HD, which means if you want to avoid HD, you'll need to look 
for an older, probably used, SD camera.

Anything shooting tapeless - hard disk or flash drive - will be shooting HD.

You can edit with precision from any video format, not just tape. Some cameras have viewfinders 
- you'll need to look around.

Assuming you have a fairly new computer, look at the AVCHD family of cameras. Low cost, good 
images, lots of features.

Mike then wrote back:

Not to beat a dead horse, but this is an excerpt from PC World. It states the 
difficulties in editing HD video. How is it not a problem when you edit HD?

"Editing HDV video is still a challenge. HDV uses a compression 
scheme in which only one out of every 15 frames is completely 
captured. With the 14 frames that follow it, only the differences 
between this and the previous frame are captured and stored on 
tape (video geeks call this inter-frame compression). This 
compression is generally not visible to the human eye, although you 
can sometimes see it if you are watching a video and the whole 
screen changes from one frame to the next, like a scene illuminated 
by a strobe light. Nonetheless, it makes editing HDV video much 
more complex for the computer, as it has to recalculate all 15 



frames even if you edit only one."

Larry continued: Don't mix acronyms....!

HD is the entire world of high-definition video - currently, it contains about 400 different formats. 
ONE of those formats is HDV.

A good analogy is that all Toyotas (HDV) are cars (HD), but not all cars are Toyotas.

PC World is correct in that HDV uses inter-frame compression - called GOP. So does AVCHD, 
XDCAM HD, XDCAM EX. Other formats of HD, such as DVCPRO HD, ProRes, and DNxHD, do 
not. Also, the article is correct in that editing software needs to deconstruct the entire GOP 
(which contains either 7, 12, or 15 frames, depending upon format) before it can edit an image.

There are two problems with GOP compression - quality (which we can argue about) and 
conforming. Conforming is the time-consuming process of converting the HDV video from a form 
necessary for editing into a form required for output. Depending upon the speed of your system 
this can be anywhere from 3 to 12 TIMES longer than real-time.

The article recommends against using HDV. So do I. But that is NOT the same as 
recommending against HD. There are many excellent HD formats you can select from - 
depending upon your needs and budget - that are not HDV. 

Here's an article that can help. 

Here's a video tutorial that can help even more. 
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AUDIO CLICKS

Stephen Ashton writes:

I am working on a project that was developing 'Clicks" on the sound track. I 
subsequently exported the track and reset it to 48 kHz as recommended but the 
old clicks are still there.

How can i remove them without chopping each one out individually?

I am using FCP 5 and Soundtrack 1.

Larry replies: Clicks are indicative of compressed audio in your timeline - be sure to only use AIF 
or WAV, not MP3 or AAC.

If you are using a compressed format, use QuickTime Pro or iTunes to convert the file. Here's an 
article that describes how to do this in iTunes -- I haven't written one yet on how to export a file 
from QuickTime Pro. 

UPDATE - Dec. 28, 2009

Lawrie Edison writes from Canada:

http://www.larryjordan.biz/articles/lj_video_data_rates.html
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?cPath=29_30&products_id=110
http://www.larryjordan.biz/articles/lj_convert_mp3.html
http://www.larryjordan.biz/articles/lj_convert_mp3.html


You probably already know this but a quick fix is to do an 
audio crossfade of only a frame or two.

This may not be Stephen's issue but I've noticed certain files (for me, a 
whoosh sound effect especially) to need this treatment.

Matt Davis adds: 

Could Stephen be referring to the clicks and thumps on audio edits where the cut 
happens to be where the two clips' sound waves (and we're talking AIFF 48k 16 
bit) 'collide' at the cut point and don't cross over at 0? In which case, the two 
heavy handed ways to get around this would be to apply a 1-3 frame cross fade 
(when you're in a hurry and/or there's lot's of background noise) or a very quick 
fadeout-fadein with the pencil tool on the levels (maybe a bit of room tone dropped 
underneath to hide the join). All done in FCP.

Larry replies: Thanks, Lawrie and Matt. Your technique will solve clicks during a transition. 
However, if the clicks occur other than on transitions, its probably due to using compressed 
audio files. 

[ Go to Top. ] 

A BETTER MASTERING FORMAT

Andrew Wilson writes:

Once upon a time, I shot on DV and mastered to DVCAM tape and sent broadcast 
dubs out on DVCAM. Then I started shooting with an XDCAM-EX1 but still 
mastered to tape on a DVCAM deck in SD. So I would edit the EX1 footage into a 
sequence set up for miniDV/DVCAM in Final Cut using the DV/DVCPRO codec.

Now - all my broadcast spots are being sent electronically and long forms are 
being mastered to DVD or prepped for internet distribution so I really no longer 
use the DVCAM deck at all.

My question... Since I'm still mastering in SD (for cable-cast and DVD) but not 
mastering to tape anymore, there must be settings in FCP that will give me better 
quality than the DV setup. What sequence settings should I be using to get the 
highest quality possible since I'm not mastering to tape anymore? Did you hear 
that? Not mastering to tape anymore! 

Larry replies: Yes, I know. The phrase: "Not mastering to tape." makes me feel like we have left 
Kansas far behind, as well.

Depending upon which version of Final Cut Pro you have, the highest quality format varies.

* For FCP 5 or earlier, use Uncompressed 10-bit.

* For FCP 6 or later, use ProRes 422 (HQ). While you could use ProRes 4444 in 
FCP 7, this is really designed for media transfer and effects. ProRes 422 HQ is 
designed for video editing.

[ Go to Top. ] 



WHEN TO TRANSCODE

Allon Baron, from Australia, writes:

We hear a lot about transcoding, especially to prores. 
Can you please advise a good workflow or is it specific to the camera. 
I'm not sure if its what you do when you ingest or media manager or compressor. 
We shoot with a Canon HV30 with the usual stuff, macbook pro, current FCP etc...

Larry replies: Allon, thanks for writing!

Transcoding is the process of converting from one video format to another; for example, from 
HDV to ProRes, or HDV to SD. This transcoding can happen in three places:

1. Before editing 
2. During editing 
3. After editing is complete

For instance, AVCHD is transcoded during ingest from it's native MPEG-4 format into ProRes so 
that Final Cut can use the much more editing friendly ProRes codec for editing.

In general, if you only shoot using one camera format, ingest in that format, edit in that format, 
output in that format, then, if necessary, transcode into your final delivery format. However, as 
you start to mix cameras and formats, transcoding becomes increasingly necessary. 

Here are some other scenarios: 

If you are mixing both HD and SD in the same SD timeline, you could simply edit 
the HD footage into your sequence and FCP will automatically transcode it into 
SD. (What it actually does is render the HD footage into SD, which means your 
source files are not affected.)

When you are done with a project - say in HDV - you could export that as an HDV 
project and transcode it into another HD format for distribution to a broadcast 
station.

My recommendation is that if your hardware supports it and transcoding is necessary, transcode 
to ProRes during ingest and edit your project using ProRes.

Final Cut provides a variety of both Easy Setups and customized Sequence settings - so that you 
can pick your source media and the ProRes version you transcode into.
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PICKING A HARD DRIVE

Joe Louw writes:

Greetings from a very hot South Africa!



I’m planning to buy a hard drive for my FCP documents only, I’m currently using a 
USB 2 external 500GB on my iMac with FCP. (Yes I know it’s not the best choice 
but that was all I could afford at the time.)

 
 
I noticed you mentioned on one of your Lynda.com titles that one should set the 
“limit real-time video” setting under: User preferences; general tab, to 22MB/s for 
FireWire 400 and 42MB/s for FireWire 800 and OFF for RAID. 
 
My question is: If I use a RAID 0 or RAID 5 external FireWire 800 drive on what 
should I set it then? I figured that the OFF setting is for RAID drives on a MacPro 
built into the machine via SATA or e-SATA.

Larry replies: Thanks for writing - we are hearing from a LOT of countries this month! 

This dialog sets FCP's expectations of how fast it should expect data from your hard disk. It uses 
this information to determine what can be displayed in real-time and what needs to render.

You should set this based on how you are connecting your hard drive. For FireWire 400, set it to 
22 MB/s. For FireWire 800 (whether a single drive or a RAID), set it to 50 MB/s (I've changed my 
opinion on this number and raised it somewhat.)

For eSATA or PCIe devices, leave this dialog box unchecked.
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PROBLEMS CONNECTING 

Jeff Brenes asks:

I have a SONY HVR V1 camera, and I was trying to connect it as a DECK to Final 
Cut Pro.

Actually I did it, and it worked as external monitor, I can even use it to connect 
FCP to my TV. But I was trying to send my sequence (DV/NTSC format) from FCP 
to a tape using the Master to tape command and then things stop to work. The 
camera begins to record (I can see the red dot in the screen and tape is rolling), 
but the image stops to be transmitted to the screen of the camera and of course it 
never reach the tape.



The thing is that I´m not sure how to set the FCP and the Camera/DECK in the 
proper way to connect each other and transfer my sequence to the tape.

Larry replies: If you are sending DV images - rather than HDV images - to the camera, here are 
some things to check:

* Be sure the camera input is set to iLink 
* Be sure the camera input is set to DV, not HDV 
* Be sure your sequence settings are DV 
* Be sure camera is in VTR mode. 
* Be sure, in FCP, that View > Video playback is set to point to your camera

I don't own this camera, so if those suggestions don't work, you'll probably need to contact Sony. 
Let me know what fixes it.
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PICKING IMAGE QUALITY

John Martellucci writes:

I have watched your tutorial on Lynda.com covering moving stills... resizing to 
1800 x 1350 x 72, Bicubic options, sRGB gamma setting, etc... fantastic info!

The project I am working on will incorporate both video and photos. I have 490 
scanned photos (but in jpeg format).

I'm planning to bring all the photos into Photoshop and make the adjustments you 
explained in your tutorial... and per your recommendation, was also planning to 
save them as a Tiff... with the LZW compression.

However... since the existing format of the photos I am bringing into Photoshop is 
jpeg, will the quality be improved by changing it to Tiff... or are my efforts pointless 
and futile? 

Larry replies: John, thanks for writing!

Converting a JPEG to TIFF won't improve quality. It just changes the format. Think of pouring a 
cup of water into a five gallon bucket. You've changed the size of the container, but not the 
content. 

Since you are going to standard def video, as I assume from the image sizes you mentioned, 
JPEG will "probably" be OK - do a test and see if it works for you. Things that may get damaged 
are thin lines, fine detail, subtle textures - which SD video tends to not display anyway.

For HD video, it will probably be better to re-scan as TIFF --- BUT!!!!! do some tests first. If you 
can't see a difference on a good monitor, there probably isn't a difference. TIFF or PNG are 
better, but when compared to a really high-quality JPEG, it may not be enough to notice.

If you are creating this project for digital cinema, rescan the images to TIFF. When projecting to 
large screens, anything you can do to improve image quality is a good idea.



In general, I am not a fan of JPEG, compared to PNG or TIFF, due to the lower quality of JPEG. 
However, if JPEG is all you have to work with, Final Cut can easily edit them. 
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TROUBLE-SHOOTING FRAME RATES

Trevor Hughes writes:

I would also like to give you a feed back for a problem I had some time ago and it 
was some thing you had not seen before. I now have the answer.

If you can remember I sent a photo of a timeline with empty frames between clips. 
The contents of this timeline was copied from another sequence / project that 
myself and a friend were working on.

Yes, it happened again and I thought: Oh No! Why?

The answer was: the contents of both sequences were the same in the seq. 
setting EXCEPT for the frame rate -- 25 v 50 PAL -- As soon as the frame rates 
matched, no more problems.

Larry replies: Cool! Thanks.
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FINAL CUT PRO 7 BUG

Dennis Rosenblatt sent this in:

I just figured out something that was driving me a bit insane and thought i'd pass it 
along.

I'm doing a multicam project and couldn't figure out why every time i brought it into 
the timeline, the render bar went red and prevented me from cutting or screening 
the multiclip in real time.

Problem turned out to be, that i had the video scope open. I can't figure out why 
this should have that effect on it but it sure does.

Pretty odd and inconvenient.

Larry adds: Yeah, and weird, too.

[ Go to Top. ] 

VIDEO COMPRESSION PROBLEMS



Seigo Saito, from Japan, writes:

I am exporting a ProRes 1920x1080 60i clip as a self contained movie. I then 
selected the 120 min. best quality preset in compressor to make my MPEG-2 and 
AC3 file for SD DVD. The quality is pretty bad. I get jagged edges and horizontal 
lines in the MPEG-2 file and all text is of poor quality.

Larry replies: Thanks for writing!

Try doing this compression in two steps, because the quality of the 120 minute setting is 
somewhat low. Compressionists call this "Pre-Compression," which means to prep the file into its 
final format before compressing it. When you need to create multiple compressed versions of the 
same file, pre-processing can save a lot of time. 

1. Resize your HD movie to SD using Compressor but don't compress it.

* Encode it to ProRes HQ

 
* In the Frame Controls tab, turn Frame Controls On, set Output 
Fields to Progressive, Deinterlacing to Better, and turn Adaptive 
Details Off. 



 
* In the Geometry tab set image size to 853 x 480 using a custom 
16:9 aspect ratio

2. See how your movie looks. It WON'T look as good as HD, as the image 
resolution is seven times smaller. But it should look OK. The best approach is to 
work with only a short - say 20 second section - to save time until you get the 
settings you want.

3. Then, compress the resized image to MPEG using the DVD Best Quality 120 
minutes setting.

This two-step process takes a bit longer, but should provide a lot higher quality.
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WRAP-UP

Well, that's about it for this newsletter. I STILL have over 70 reader questions to go. I'll get those 
into another newsletter and out before the year ends -- I hope.

For current news and in-depth interviews on what's happening in our industry, be sure to listen to 
the Digital Production BuZZ every week. In fact, email me on how you can put the free BuZZ 
player on your website! 

�●     Visit our store and buy some of our latest tutorials. 
�●     Check out our current seminar series, I'd love to meet you! 

Also, please continue sending me your comments and questions. I love hearing from you and 
enjoy the conversations that develop around your comments.

Until next month, take care, and edit well.

http://www.digitalproductionbuzz.com/LiveThisWeek
mailto:larry@larryjordan.biz?subject=FREE BuZZ Player
mailto:larry@larryjordan.biz?subject=FREE BuZZ Player
http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/seminars
mailto:larry@larryjordan.biz?subject=Newsletter comments


Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2009 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require 
prior permission. 
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